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1.0 Introduction  

Definition: What is AutoCAD?   

AutoCAD is defined as a computer aided application for that are being most utilized in  

Engineering works application, the application of AutoCAD was designed so as it could be used for PCs 

only. The use of the AutoCAD for engineering works has become the best useful software in the world, 

specifically in the CAD business. AutoCAD application are mostly useful software in geometrical 

drawings which suit both in 2D and 3D drafting and designing. General AutoCAD are being commonly 

used in engineering works such as; in Architectural, Structural, Mechanical, Electrical, Environmental 

structures, and Manufacturing drawings which  including  Roads, Railways and Highway designs.  

AutoCAD is more useful in Building Information Modelling (BIM), it is the most profitable software 

for Autodesk, due to its ease of use and comprehensiveness, which normally address all user needs.   

AutoCAD is normally a program that developed as a useful working tool for most engineers works it 

assists in drawing and detailing drawings of construction parts and floor plans drawings. In this modern 

world, computer application is for everyone which has soften the life, AutoCAD is actually significant 

programme to any practicing engineer.  

It has much assistances in designing ideas and envisaging the concept through realistic interpreting. 

Generally, drawing is a technique which used to present and demonstrate a diagrammatic details of 

information to the mass of peoples to explain the working, a design, and arrangement of the products or 

components of the intended structure into truly understood.   

This is the common language for most engineers which encompasses most engineering disciplines such 

as Mechanical, Electrical, Civil, Architectural and structural proficient. AutoCAD is the software use to 

support engineers in developing drawings to conceptualize the ideas required to be conveyed into a 

reality one. In general AutoCAD is a computer modelling software used to create @D as well as 3D 

drawings of several objects   
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AutoCAD it remain as a computer Aided Design, with high effectiveness, low rate of errors, less input 

cost. It have been more casted out from the traditional manual methods of drawings. The software is 

widely used in the world, for engineering works as well as in majority training institutional such as 

Schoolers, Colleges, Vocational education students, and university students.With good ascendancy and 

solid modelling, the AutoCAD is a multilateral software which can be competitively managed by various 

engineering design with direct achievement to financial efficiency, largely, AutoCAD it runs on 

Microsoft Windows application.  

  

 1.1 Review Questions- One  

A - Multiple-choice questions.  

Q1. File tab will show the model space and layout of the opened files    

(a).True   

(b). False    

Q2. The AutoCAD template file extension is normally presented by the following symbol    

a. *.dwg   b) * dwt   

c. * .tmp   d). * .temp   

Q3. AutoCAD units can also be a meter or foot, as desired by the user.   

a.False   

b.True   

 Q4. Moving the wheel forward will mean Zoom in the object function   

Q5. To undo any command in AutoCAD you can:   

a. All below can be applied  

b. Click the Undo icon from the Quick Access Toolbar   

c. Type u at the command window  

d. Type [Ctrl] + Z   

 

Q6. Ribbons in AutoCAD’s processes consist of two parts; tabs and Panels   

Q7. The menu bar by evasion is not indicated, but it can be show it if you want it   

a. False   

b. True   

b 

a 

b 

a 

b 
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Q8. The AutoCAD drawing file extension is known by *.dwg  

Q9. In the AutoCAD the positive angle are created by moving it in the direction of counter clockwise  

(CCW)  

 

Q10. To mention four important drafting commands that are being used in AutoCAD  

application   

 Answer; The most important commands in AutoCAD application are   

1. Line command, used in drawing line segments of any object   

2. Arc command, use in drawing circular arcs of an objects  

3. Circle command, that can be used in drawing cycles and   

4. Polyline command that can be used for drawing lines and arcs jointly   

Moreover, in the application of drafting process commands, there are some accuracy tools which are 

being used to speed up the drafting process commands; this are used as the first prompt commands; 

1. Stipulate the recommended coordinates of your first point.   

2. Keep stipulating points, and when it is ready, the following has to be done:   

a. If you want to stop without closing the shape, Press [Enter key]   

b. [Esc key] to do the work as well, but don’t make it as a routine, as [Esc key] generally means 

abort.  

c. If you want to close up the profile and finish the command, you have to press C command on 

the keyboard or right-click and choice the close option.   

d. If you have done any mistakes, you can press undo, by typing U on the keyboard or right – 

clicking and then choice the undo option.  

Moreover; to Starting AutoCAD it mostly covenants to start with the AutoCAD interface, AutoCAD  

Evasions and drawing elements, also deals with oriented file commands, Undo and Redo Commands.  

However, a Dynamic Input has multiple functions as follows   

 It will show a stimulates at the command window in the graphical area.  
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 Also it will show the dimensions and angles of the shapes before drafting, which will postulate 

the accurately position of the object.  

Q11. The exact angles (Ortho vs. Polar Tracking) are incremented by 1°, the ortho function are normally 

used to provide the object (lines) be at the right angles (orthogonal) by using the following angles:  

a) 0, 90, 180, and 270  

b) 30, 45, 60  

c) 0,30,45,90.180 and 270.  

 Q12. The object SNAP (OSNAP), is used as the most accuracy and important tool in the AutoCAD for 

2D and 3D as well. Also it is the way use to specify the points of objects exactly with the AutoCAD data 

base stored in the drawing file.  

a) True  

b) False  

Q13. In general some of the object SNAPs are; endpoints used to catch the endpoint of the line, or arc 

midpoint used to catch the midpoint of a line or arc, the intersection used to catch the intersection of the 

two objects, also the perpendicular are used to catch the perpendicular point of an object, nearest to catch 

a point on an object nearest to clicking point.  

(a ) True (b) False  

 

Q14. If the top wall contains only one Window, and you want to sightsee how the elevation will look 

with a few additional windows?  

Answer First Click a point outside and above the model to the right, and then transport the  

mouse to the exterior left of the model just below the upper Wall, and click again, this is called a crossing 

selection window   

a) False    b)True  

 

a 

a 

a 

b 
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“Q 15 and 16 insert YES or NO at the end of Sentence that accepting the procedure or not 

accepting” 

 

Q15. Creating a Model View for the building; having created the separate portions of the building, the 

following steps can be followed.  

1. On the Project Navigator palette, click the Views tab. YES  

2. You can right-click on the Views file and choose New View Dwg. General. YES  

 For the Name, type Model and then click next. YES  

 You can also click forward to unsteady type of model.  NO  

 On the Context screen, check all three Levels and then click next. YES  

 On the final screen, click Finish. YES  

3. On Project Navigator, double-click Model to open it. YES  

 On the View panel, choose View, SW Isometric from the View drop-down button. YES 

 On the View panel, choose View, SW Isometric from the View drop-up button. NO  

 In the default installation, the View panel is torn on and floating onscreen NO  

 In the default installation, the View panel is torn off and floating on screen YES  

 On the View panel, choose Visual Styles, Conceptual from the Visual Styles drop down button 

YES  

Q16.Viewing the model in 3D it gives the opportunity to see how the design is coming along and 

consider modifications in required, this it is easy to make changes and then quickly view the results. 

YES  

1.  Click on the second floor in the Model file to select it YES  

2. For the entire floor plate highlights the Model is comprised of External References  

(XREFs).YES  
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3.  A small floating properties palette are called Quick Properties, YES  

4. A small floating properties palette are neither called Quick Properties No   

5. A small floating properties palette are called Quick Properties which appears as selected  

Confirming XREF YES.   

6. An XREF is a link for the original file that updates when changes to the original are made. YES   

7. Project Navigator automatically creates all XREFs for the user when they set up a View, YES.   

8. While choose Open XREF. for the Second Floor Build that file has opened onscreen you  

normally supposed to wright click. YES   

9. You could have to open it from Project Navigator, this method can sometimes be very slow.    NO.  

10. It is advised that you can select the vertical wall on the right. If you highlight the Slab  

instead, press the ESC key and try again.    YES      

11.  Click the square Location grip at the centre of the Wall. Begin moving it to the Left, .type  

5 0 -000 [1500] and then press ENTER. YES  

Q17. How can the Horizontal walls at the pot and bottom for   a strained to stay connected to the  

one if are removed, while   the Windows are in undesirable locations?  

Answer: This can be moved by selecting them, then clicking the square location grip in the center       

and then move to a new location. Also you can use the AEC Modify tools to re-center and space  

Windows. Moreover on the design Tool palette, you may click the Column tool, the Properties  

Palette, changes the Logical length to 80 -000 [2750].  
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  At the “Insert prompt point”, you may click a point near the corner of the Slab where the  Wall was 

previously, and then press ENTER to agree the default rotation, this can be repeated to the  other corner, 

and then press ENTER to complete the command.  

Likewise on the interior of the building, you can add Space objects that represent the rooms in the plan 

that can be used to add room tags and calculate square footage later. Whereas, on the Project Navigator 

palette, this can be achieved by clicking the Constructs tab and then double-click the First Floor file 

(FFF or F3) to open it. On the Walls tab of the Tool.  

Palettes, you just click the Stud 4 tool, then click a point which is between two of the Windows at the 

top of the plan and thereafter click an opposite point at the bottom of the plan. This exercise, precisely 

is not important, because you can hold down the SHIFT key, and Right-click to access the snap menu.  

The Snap menu is nearest for the first point to Intersection or is perpendicularly with the other point. 

Also on the Design tool palette, you can also click the Door tool and then add a Door to the new wall 

then press ENTER to complete the command. Thereafter, on the Design tool palette, click the Space 

tool. In which from there “Create type” list, choose Generate.  

1.2 Creating Meshes with AutoCAD’s  

Normally there are various meshes that can be created by the use of auto Cads, which include   

Mesh Basic Shapes; The Mesh basic Shapes, involve Gizmo and Mesh sub objects. Also mesh basic 

shapes involved in creating meshes from 2D objects, Converting smoothing, refining and creasing, as 

well as face editing commands.   

By definition; MESHES are solid like objects excepting that meshes do not have mass or volume.  

In the other hand, meshes are normally have a unique ability which normally does not exist in solids, it 

can also be formed to distinguish irregular shapes and that is why the Autodesk call it Free from design. 

In general meshes consist of faces which the users can specify, and in other words faces consist of facets. 

Meshes can be able to increase their smoothness when asking by AutoCAD user to take it to the next 
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level.  Actually the AutoCAD may increase the number of faces to create a smoother mesh, that means 

facets are under AutoCAD control, and users can’t edit them properly.  

However, there are seven basic meshes shapes in which all commands can be found in the Mesh tab and 

the Primitives panel, this are; Mesh Boxes, Mesh Cylinders, Mesh Conns, Mesh  Pyramids, Mesh 

Spheres, Mesh wedges, and Mesh Torus.  

1.3 Commands for Generation of Meshes  

 To describe four Commands that could be used to generate Meshes during application of  

AutoCAD’s.  Meshes can be generated by using four commands to convert 2D closed or open shapes to 

meshes, these commands are: a) Revolved surface. B) Edge surface. C) Ruled surface and   

d) Tabulated surface.  

Generally to set the density of the meshes generated from the above four commands, normally use the 

two system variables SURFTAB1 and SURFTAB2. While for the Ruled surface and tabulated surface 

commands only SURFTAB1 is normally being used. Thus SURFTAB1 and SURFTAB2 are being used 

for Revolved surface and Edge surface commands.   

1.3.1 Revolved Surface Command   

This command normally allows for creation of 2D object open and close of meshes by rotating it around 

an axis with the use of angle. This can be attained by commanding the Mesh tab, find the Primitives 

panel, and choose the rotated Surface button.  

Where by during application the following prompts may be seen; “Current wire frame density:  

SURFTAB1=16 SURFTAB2=16” then Select the object to revolve. After there, select the object that 

defines the axis of revolution, Specify start angle <0>: The Specified included angle (+= ccw, = cw) 

<360>.  Where the first line reports the current values of SURFTAB1 and SURFTAB2, then the reports 

are repeated with the other three commands, however, the second prompt command asks to select only 

one 2D open/closed object. At this case the user would choose an object which representing the axis of 
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revolution. Fourth, stipulate the start angle if it was other than 0 (zero). Finally users should specify the 

angle to be included, keeping in mind that CCW is positive.  

1.3.2 Edge Surface Command   

This command normally allows the user to generate a mesh with four 2D open shapes. In order the 

command to be successful, the objects are touched at each other to form a closed shape with four edges.  

In order to issue the command, actually go to the mesh tab, locate the primitive panel, and then choose 

the edge surface button. 

Follow the prompt command that will be displayed after there a current wire frame density 

SURFTAB1=16 SURFTAB2=16; then choose object one surface edge, choose object two for surface 

edge. Choose object three for surface edge and then choose object four for surface edge. 

1.3.3 Ruled Surface Command  

 This command enables the user to create a mesh between two objects, where one of the following 

Variations can be achieved “Two open 2D shapes and or Two closed 2D shapes” therefore Open shape 

with point Closed shape with point; for this case you require to do the following, go to  the Mesh tab, 

locate the Primitives panel, and then select the Ruled Surface button. The AutoCAD will display the 

following prompts: Current wire frame density: SURFTAB1=24; the user is supposed to select first 

defining curve and then select second defining curve:  

1.3.4 Tabulated Surface Command   

The tabulated Surface Command normally allows the user to generate a mesh using a 2D profile open 

or closed an object. To issue this command, you necessitate to gate into the Mesh tab, locate the 

Primitives board, and select the Tabulated Superficial button. After there the AutoCAD will display the 

subsequent prompts: Contemporary wire frame density: SURFTAB1=24.The user will hence first-rate 

the object for path curve; thereafter, the object for direction vector. In which the first line will report the 

current value of SURFTAB1. The second asks the user to select the path curve, and the third prompt 

asks for selection on the direction vector.   
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1.4 Creating Surfaces  

Generally, the AutoCAD has two types of surfaces Commands which are: Procedural Surfaces and  

NURBS Surfaces. Procedural Surfaces are type of surface that keeps a relationship with the objects 

formed from it and it will change any time if they change. Procedural Surfaces are associative objects.    

NURBS Surfaces: This are type of surfaces that has Control Vertices (CV), which normally allows the 

user to manipulate the surface as if he/she were sculpting. NURBS Surfaces are not associative objects 

In order to control the type of surface to be created, go to the surface tab and locate the generate panel.  

The user must pay courtesy to the two buttons at the right. If the NURBS creation button is on, the 

resultant surface is NURBS. If the surface associativity is on, the resultant surface is Procedural, however 

this application is actually done for all types of surfaces, except on Planer Surface.  

1.5 Creating Complex Solid and Surfaces  

In AutoCAD’s application, creation of complex solids and surfaces can be achieved using the following 

commands;-  (1) 3D Poly and Helix commands. (2) Extrude command.  (3) Loft command.(4) Revolve  

command and  (5) Sweep command.  

This set of commands can actually translate 2D objects to whichever solids or surfaces using different 

methods. Moreover, the same set of commands exists as the solid tab and as the surface tab. Where the 

first set of commands will produce solids, and the second set will produce surfaces. These commands 

normally include the following commands: Extrude, Loft, Revolve, and Sweep. However, this 

commands are supported with two commands that helps in drawing a 3D path which are 3D Poly and 

Helix paths.  

1.5.1 3D Polyline   

3D Polylines as a PATH, Normally the command draws of 2D line/arc sections in the current  

XY plane, which means you can not specify the Z coordinate. However 3D Polyline allows to specify 

the  
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Z coordinate, hence the user can draw a 3D Polyline.   In this case to issue the command, the user should 

go to home tab, locate the allurement panel, and choose the 3D Polyline button where the following 

prompts will have to be shown.  

 Stipulate the starting point of polyline.  

 Specify the endpoint of line or [Undo]. 

 Stipulate the endpoint of line or [Undo].  

 Postulate the endpoint of line or [Close/Undo].  

Associate with the regular polyline commands, the command will enticement only the line sections as a 

prompts propose. Polyline edit command has an effect over editing 3D polyline with some variances.  

The following cannot be set the width using Polyline edit which you cannot use. Fit option, you cannot 

use line type with generation option.  

1.5.2 Helix as a Path   

This command normally allows you to draw a 3D coiled shape, whereby to issue this command, it 

requires to go to the home tab, locate the Draw panel, and choose the Helix button.  The subsequent 

prompts will then be shown: Number of chances = 3.0000; Curl=CCW Stipulate center point of base: 

postulate the base radius or [Diameter] <1.0000>: Postulate top radius or [Diameter] <47.1835>: Identify 

helix height or [Axis endpoint/Turns/turn Height/twist] <1.0000>:  

1.5.3 Assessment Leaning Questions Two  

1. Which among the following statements is false?    

a. DELOBJ has got three difference values.   

b. Hurried Properties and Properties will display different information for surfaces and solids.   

c. You cannot deliberate line as a sweeping path.   

d. You can delete the profile afterward, finishing the revolution by using the DELOBJ system 

adjustable.   

c 
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2. All of the subsequent commands are options in Loft except one:   

a. Pathway   

b. Leader   

 c. Standard to all segments   

d. Standard to no segment   

3. Twist and Scale are the an options in Sweep commands  

4. While exhausting the Revolve command, the alignment of revolution must be always a drawn object:   

a. True   

b. False   

5. Using the grips of an extrusion you can make an amendment to the taper angle.   

a. True    b. False   

6. The evasion twist of the helix is 3D spiral Command   

1.6 Solid Editing Commands  

In Solids editing commands it is normally involve, Solid faces manipulation, commands Solid edges 

manipulation commands, and Solid body manipulation commands.  

The AutoCAD particular command which may be able to edit the whole thing that related to the solid 

object, specifically the edges, faces, and the entire body of the solid. This command is called solid edit, 

it normally comes when using the command window and keyboard only. But the command is long and 

tedious. However to make your life easier, AutoCAD customized all of solid edit options in the ribbon 

interface.   

1.6.1 Assessment  Three  

1. You can counterbalance faces and edges of the solid.   

a. True   

c 

a 

a 

b 
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b. False  

2 One of the subsequent statement is false.  

a. Counterbalance faces can offset both planar and curved faces.   

b. Extrude faces can offset only planar faces  

c. Extrude faces can offset both planar and curved faces.   

   d. Counterbalance faces can offset curved faces  

   

3. In directive to make a manipulation to the CV of curved surface the degree should be Three at least.    

  

4. The variances between the Cutting Edges command and Copying Edges command is:   

 a. In the Copying edges command you cannot choose the desired edges.   

b. In the Extract Edges command you can choose the desired edges.   

c. In the Copying edges command you can select desired edges.   

d. They are the same.   

5. In the Intervention command, you have to choose two sets, and each set comprehends a single object.    

a. True   

b. False   

6. In case you extrude face command, you can then use path with Taper angle.   

   a. True   

b. False  

7. While using the Revolve command when therefore have two or more non- continuous solid volumes.   

  

 8. Occasionally, AutoCAD will reject to delete a selected face.   

a. True b. False   

9. Theu users in general can delete a fillet of a solid.   

a. True   b. False   

 

10. With the use of an Array command in a 3D environment, the users can usually Levels and 

incremental advancement to utilize the 3D feature of this command.  

  

11. In fact there are distinctive commands to filled and chamfer solid edges.   

a. True   

b 

b 

b 

a 

a 

a 

b 
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b. True only for tangent edges  

c. True, but you still can use the regular Fillet and Chamfer commands that used in 2D  

d. False   

 

12. By using 3D Mirror command:   

a. You should postulate a mirror plane using 3 points.   

b. You would postulate a mirror line just like 2D.   

c. You would specify a mirror plane by XY, YZ, ZX or any parallel plane to them.  

   d. A & C.   

13. If the loop option in a chamfer edge commands is to be effectively, the edges would be tangent to 

each other.   

a. True  b. False   

14. In case the Chain option in Fillet Edge command is to be effective, the edges should be tangent to 

each other.    

a. True   

b. False   

 

1.7 Review Questions Four  

Answer the following multiple choice questions  

1. Thicken will convert a mesh to a solid.    

 a. True b. False  

 2. This command will create an inclined face using two points. Positive angle means the face will 

incline inward, and negative angle will incline outward   

  

3. Which of the following is not a method to create a section plane?   

a. Selecting a face  

b. Parallel to one of the XY, YZ and ZX. Planes  

C.Draw section    

d. Orthographic   

 4. Convert to Solid will convert both meshes and surfaces to solids.   

  a. True b. False   

5. While creating a slice plane the following methods are true except one.  

a. Planar object b. 3 points c. Orthographic d. Surface   

b 

a 

b 

b 

c 

b 

c 
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6. In Shell command, inputting a Negative value means the outside edge of the solid will be the inside 

edge and the offset will be to the outside.   

7.  The following Statement are true except one is false    

a. Offset faces can offset both planar and curved faces.  

b. Extrude faces can offset only planar faces.  

c. Extrude faces can offset both planar and curved faces.  

d. Offset surfaces can offset curved faces.  

  

8. The variances between the extract edges command and Replication Edges command is:   

a) In the Copying edges command you cannot choose desired edges.  

b) In the Extract Edges command you can choose desired edges.  

c) In the Replication edges command you can select desired edges. 

 d) Those are statement are  similar   

  

9. In the Intervention command, you have to choose two sets, and each set comprises a single object.   

a) True b) False  

10. You can offset surfaces and edges of the solid.  

(a) True (b) False  

11. The Interference command between solids will help the user to find (create) the common volume 

between two sets of solid objects.  

12. For the Extrude face command, you may use Path with Taper angle.  

a. True   b. False  

13. Occasionally AutoCAD may decline to delete the selected face.  

a. True b. False  

  

14. To mention sequentially four command that can be used with some of the solid objects.   

Answer: The subsequent are solid objects that can be transformed to surfaces using the Explode 

command: 

  1) Cylinder.  

2) Cone  

3) Sphere  

c 

C 

b 

a 

b 

b 



 

 

 
17 

4) Torus.  

Normally the convention of cylinder, the top and bottom of the cylinder can be transformed to region 

and the body of the cylinder can be transformed to surface. As for the cone, the bottom can be 

transformed to region, and the body can be converted to surface  

 

 15. One of the following is not related to render in AutoCAD:  

a. You can control render output size.  

b. You can control render output file size.   

c. There are two types of rendering in AutoCAD.         

d. Render using different presents  

 

16. There are three (3) methods to allocate materials to objects, one of them is “Attach by Layer.”  

a. True b. False  

17. Render Region will allow you to render rectangular part of the scene. 

 

 

 

 

 

 

 

 

 

 

 

 

 

b 

a 
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1.8 Conclusion  

This course have provided a clear understanding on how to apply  AutoCAD’s in Civil engineering 

activities, clearly  discussion of 2D and 3D environment and commands in AutoCAD have been properly 

understood.  

The course had increased the abilities on AutoCAD application for 3D objects, leading the use of 

AutoCAD software, to create lights, load materials, and assign materials.   

During achievement of this lesson, it has enabled to have better skill regarding on the application 

following of the software system;-   

By understand the AutoCAD 3D environment, enabled in Generating 3D objects using solids, 

Generating 3D objects using meshes, Generating 3D objects using faces, creating a Complex Solids and 

Surfaces, editing Solids and also the use of other general 3D modifying commands.  

Moreover, by passing through the course work, it have helped much, and  gained a knowledge on how 

to transform 3D objects from one brand to another, also creating 2D/3D segments from 3D solids. Using 

the model documentation,   creating 3D- DWF files, Creating cameras and lights , assign materials and 

creating rendered images ,use and create visual styles of various solid shapes and Create animation files 

with the use of AutoCAD’s Software.  

Finally this course has contribute in building up my knowledge and capacity on working with  

AutoCAD’s software in my working place and had increased more knowledge on the the usefulness of 

Auto CADs.  
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